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Overview — Key Concepts 

A spreadsheet consists of columns (which take priority and are referred to by letters) and rows (which come 
second, referred to by numbers). Where they cross is a “cell.”  Each cell has an address (letter plus number, such as 
“A1”). 
 

 A B C D E F G 

1 A1 B1   Text Number Format 

2  B2 C2  Chicago 39 $1,234.55 

3    D3 Milwaukee 2987.65 6/8/09 

 
A cell can contain five kinds of content:   
 

 Text (aligns left to right) 

 Numbers (aligns right to left) 

 Formats (such as $1,000.00 or 2/15/05 or 27.5%) 

 Formulas (that do math and that you manually type in) 

 Functions (more complex calculations and operations that Excel performs for you).  
 
Text is anything that is not purely a number. “27a” is text; so is “60637-1234.” So when entering numbers, only 
type numbers (not $ or , or %)—those are formats, and are usually easiest applied once your data have been typed 
in and edited. Remember also to never use spaces (blank spacebars) in numbers, formulas, or functions. 
 
A formula (or equation) adds, subtracts, multiplies, or divides; it can use numbers or cells or both. It always begins 
with an equal sign (=), and then shows the operation to be performed.  For example, =27+36+99+18 yields the 
result 180.  A formula can also be based on cell addresses (such as =a1+a2+a3–d27). Formulas recognize the 
following symbols:  + (addition), – (subtraction), * (multiplication), / (division), and ^ (exponent, or power).  In a 
formula, always remember the mathematical order of operation, or PEMDAS: 
 

() Parentheses— ^ Exponent— * Multiplication— / Division— + Addition— - Subtraction 
=(2+3)^2*4 would yield the result 100 

 
A function is an operation Excel performs for you; it always begins with an equal sign (=), followed by a named 
command (such as “sum” or “average”), a set of parentheses ( ) defining the area to be used, and a cell range (such 
as a1:a200) called the “argument.” For example, the function =average(a1:d1) would return the average of all 
numbers in cells a1, b1, c1, and d1.  The most commonly used function, “sum” or Σ, is for totals. You never have to 
type functions—they are provided on the ribbon, in a variety of locations. You will find them on the drop-down for 
Sum, on the fx button on the formula bar, and on the “Formulas” tab of the ribbon. 

The Screen 

The Excel work screen is divided into parts. In the upper left corner is the “Quick Access” toolbar (for putting 
commands you use frequently). Then you have the tabbed “ribbon”: File, Home (common commands), Insert 
(graphics), Page Layout (margins, paper size), Formulas (functions), Data (sort and select), Review (track changes), 
and View (screen layout). These tabs are “grouped” into categories (such as Font or Alignment), which frequently 
offer expandable dialog boxes with more options.   
 
Below the ribbon is the “formula bar” where you edit your information. As you type, you see your data in the cell 
you have selected, but it also appears on the blank white line of the formula bar. At the beginning of the line is an 
“X” (cancel, same as ESC) and a ““ (OK, or enter) on which you can click, as well as an fx for accessing the func-
tions. At the beginning of the line is the “cell indicator,” where you can type to move to a specific cell location. 
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Below the formula bar is the spreadsheet area (where your mouse appears as a white plus-shape — the cell 
pointer).  The spreadsheet is divided into 16,384 columns (identified by letters, which always come first, from A 
through XFD) and 1,048,576 rows (identified by numbers). Each square cell is referred to by the letter and number 
of its column and row. This makes a “sheet.” 
 
At the bottom left are the sheet tabs, where you can move to sheet 2, sheet 3, or add more sheets as needed. At 
the bottom right is a quick view toolbar for adjusting your screen. Also at the bottom is a status line, where you 
will see quick results (sum, count, average). 

Watch the Mouse! 

One of the keys to Excel is paying attention to the mouse.  There are many mouse shapes that appear, but four are 
significant: 
 

Cell pointer—selects a cell; types; highlights 

I Insertion point—inserts cursor for editing 

 Move—drag cell contents to different location 

+ Copy—repeat cell contents; Iterate—repeat cell content following a pattern 

Getting Around 

Excel provides different ways to navigate around your spreadsheet: 

By Keyboard: 

 Cursor keys Move your position up, down, right, and left. 

 ENTER key Move your active position down one cell. Shift+enter is one row up. 

 TAB key Move your active position to the right one column. Shift+tab moves one cell to the left. 

 F5 (Go To...) A dialog box to type in any cell on the worksheet you want to go to. 

By Mouse: 

 Pointer Click on whatever cell where your pointer is located, and that’s your active cell. 

 Scroll Bar This doesn’t move your active cell, but it allows you to see other areas on your work-
sheet. 

 Name Box In the upper left corner is a box showing the cell location. Click in that box, type any cell 
you would like to go to, then hit enter. 

Ranges 

A range of cells in Excel is a group of cells that can be manipulated in a variety of ways. Ranges are essential for 
formatting and many common commands such as cut and paste. Ranges are also important when you are working 
with functions (see below), where they are often part of the “argument.” 
 

 To create a range with your mouse, place your cell pointer over a cell, click, hold, and drag the cell down and 
over until the range you desire is highlighted. 

 To create a range with your keyboard, move your active cell to the first cell of the intended range, then hold 
down the SHIFT key and cursor down and over to select the desired range. 
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 To select an entire column-range or row-range, place the pointer over the column or row Headers (The gray ) 
and click. That entire column or row is selected.  To select a bunch of rows or column, click and drag. (Tip: This 
is NOT a good way to format.) 

 To select the entire worksheet, click the blank gray corner button just above Row #1 and left of Column A. 

Noncontiguous Ranges 

Ranges where all the cells are adjacent or together as a group are called “contiguous.” You can create nonconti-
guous ranges where the cells that make up that range aren’t next to each other. Define your first range, then move 
the cell pointer to the beginning of your second, noncontiguous area.  Hold down the CTRL key, and click and drag 
to select the range. You can do this again and again to select as many noncontiguous ranges as you want, but be 
careful not to click on a cell without the CTRL key pressed — that deselects all the other ranges. 

Entering Information 

To enter text, simply select the cell and start typing. Press enter or tab when done. When entering text, if what you 
type is longer than the cell is wide, one of two things will happen: 
 

 The text spills over onto the adjacent cells, because the adjacent cell or cells are empty. 

 The text is cut off at the end of your cell because the adjacent cell contains text or data, so Excel cannot allow 
text from one cell to spill onto a cell with something in it. 

 
Solve either of these problems by widening your column width, or adjusting the row height and using word wrap  

( ). 
 
To enter nontext data, move to the desired cell, type the number or formula, then: 
 

 Press ENTER, which tells Excel you’ve completed inputting in that cell, and moves the active cell down one 
row, or click on the checkmark on the formula bar to confirm your decision yet stay in the same cell. 

 If you change your mind or made a mistake and haven’t yet pressed ENTER, either hit the ESC key or click on 
the “X” on the formula bar to cancel. 

 After you input your data and confirm it, if you realize you made a mistake, you can either choose UNDO from 
the quick access toolbar or simply hit the Delete key to clear that cell’s contents. 

 
Sometimes a number in a cell is longer than a cell is wide.  When this occurs, you’ll see ####### across the cell.  
This means you must widen your cell for the number to appear properly. 

The Numeric Keypad 

Many people overlook the keypad on the right-hand side of a standard keyboard (not available on most laptops). 
The numeric keypad is specifically designed for numerical data entry; most people find it more efficient to type in 
numbers from there. It is particularly useful for quickly accessing +, -, *, and /. 

Editing Within a Cell 

If you move to a cell that already contains data or text and type something in, what you just typed will completely 
replace what was there.  If you want to edit a cell’s contents there are two ways of doing this. One, you can simply 
move your mouse to the Formula Bar so that the cell pointer becomes an insertion point, then click the mouse to 
place the cursor in the appropriate area.  Then, like a word processor, you can make any necessary changes. Two, 
to edit in a cell without going to the Formula Bar, double click in the cell (or hit F2) where you want to make the 
changes, and the cursor automatically appears in the cell. 
 

Excel Tip:  Be in the cell where you want the answer to appear!  As obvious as this may seem, people often write 
long, complicated formulas in the wrong cells. 



4 Formatting | Computer Resource Center, Inc. 

 

Formatting 

Once all the data are in the worksheet, you’ll want to make the sheet look as presentable and as professional as 
possible.  Formatting, simply put, changes the display attributes of cells, ranges of cells, or the entire worksheet. 
For instance, you may want a cell or range of cells to reflect currency —so the numbers should have a $ before 
them; text may look better centered within a cell, subtotals will stick out if the font is larger, bold, or bright blue.  
You may want some numbers to appear as whole numbers, without decimals.  A shaded box around the grand 
total might be an attention grabber.  Formatting allows you to control appearances for when you print. As a 
general rule, they are easiest to apply when you are finished typing and editing. 
 
There are many shortcuts on the Ribbon for formatting (be sure to select the cell or range of cells you want to 
change). The major categories of format are: 
 

 Font—Change font, size, or attributes such as bold and italic, and including borders and colors. 

 Alignment—Determine just how text or numbers align within cells—centered, flush right or flush left, at the 
top, wrapped, or merged across columns. 

 Number—Select how that number will appear—with a fixed number of decimals, as a percentage, currency, a 
date, and many more. 

 Styles—Choose from pre-defined formats, including conditional formats and cell styles.  
 

If you want more formatting options, go to the dropdown for the various formats on the ribbon.  A dialog box will 
appear with tabbed categories of the types of formatting options available. Here you will find formats for Num-
bers, Alignment, Font, Border, Fill, and Protection (see page 19). 

Widening Columns and Rows 

If your text is wider than the column, select any cell within that column.  Then on the “Home” tab under 
Cells/Format, select Autofit Column Width. If you want to adjust column width with your mouse, move the pointer 
to the gray column headers, directly on top of the line separating columns. The pointer should transform into 
double arrows when you point between the columns. Then click and drag to the right or left to widen or narrow 
the column manually, or double-click to autofit. 
 
The same instructions apply to changing row height. 
 

Excel Tip: If a number is too wide for the column, you’ll see this:  #######.  Widen the column as instructed above 
to make your number show. 

Centering Across Columns 

To make text or numbers span a series of columns and/or row, you need to use “Merge and Center.” First define 
how wide an area needs to be combined, by highlighting the desired area.  Then click on the “Merge and Center” 
button on the Ribbon (under “Alignment”).  
 
Do not select any of the three alignment buttons on the Formatting Toolbar—they align text within a cell, not 
across cells. And beware, if you highlight multiple cells that have content and then merge, only the first cell’s 
content will remain and the rest will be deleted. 
 

Excel Tip: One of the most useful shortcuts in Excel for formatting is the right mouse button. The right button is the 
menu key for whatever you are pointing at when you click. It can be extremely useful for operations like cut and 
paste, rename sheets, insert rows and columns, and even hide or unhide rows or columns for printing. 
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File 

“Save“ versus “Save as”—”Save” stores the current document in the “10” format, asking for a filename that can be 
up to 256 characters in size (automatically adding a 4-character extension, “.XLSX”). If the document has already 
been saved, pressing “save” simply resaves it with no questions asked. “Save as” allows you to save a document 
under a different name (change the name), creating a copy. It gives you an option to specify a different file format 
(such as “97-03”) or a different location. 
 
“New” versus “Open”—“Open” retrieves a document from a disk. “New” starts a blank document. If a document is 
currently in use, “New” does not clear it from the screen. The first document goes into a window (workspace), and 
the new document goes in a new window. The “New” feature is where you find the thousands of free templates 
provided by Microsoft. 
 
“Close” versus “Exit”—”Close” closes the window currently open. “Exit” closes all windows and quits Word. If 
document(s) have not been saved, both commands prompt you to save your work. 
 
Info—Permissions, Sharing, Version control. 
 
Recent—Recently used documents. 
 
Print—Print settings, as well as print preview and page layout settings. 
 
Save & Send—Email or share document (such as with SharePoint or online). Also save as PDF. 
 
At the bottom of the File tab is the Microsoft Excel “Options” screen, where you can control the default settings for 
Font, Size, Proofing (autocorrect, such as automatic capitalization), Advanced (such as “Edit Custom Lists” to make 
your own drag-down lists), and Quick Access Toolbar. 

Viewing Your Document 

The “View” toolbar (lower right corner) gives you three different ways to look at your document: 
 

 Normal—Recommended. Regular spreadsheet view. 

 Page Layout—Shows your spreadsheet as pages, with margins, headers, and footers. 

 Page Break Preview—Shows you how your content is positioned on the pages, and allows you to stretch page 
size to fit more or less on a page. 

 
To the right of the 3 view buttons is the – and + to control zoom; note this is only a screen view feature, and has no 
impact on printing.  
 
At the right edge of the bottom scrollbar and at the top edge of the right scrollbar are “Split Screen” commands, 
which you can drag to different parts of your screen to divide your screen into viewing areas. If you then use 
View/Freeze Panes, the splits will stay in place, so that as you scroll or move around in the document, you can 
keep rows showing consistently across the top or columns showing consistently on the left. 
 
On the “File” tab (and easily added to the Quick Access toolbar, top left) is “print preview.” 

Formulas 

Formulas do basic math—add, subtract, multiply, divide. You type them in; Excel never gives you formulas. Formu-
las can be based on values or on cell addresses, and they always begin with an equal symbol and contain an “oper-
ator” such as + or – (plus or minus). =27+3 is a valid formula, as is =a1-b1. Formulas never contain a space. If a 
formula has multiple mathematical operations, then the levels should be separated by parentheses—a step called 
“nesting.” 
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Excel understands the following operators: 
 

Operator  Purpose Formula Answer 

+ Addition =20+7 27 
- Subtraction =80-6 74 
* Multiplication =10*34 340 
/ Division =50/5 10 
^ Exponentiation =3^4 81 

 

Excel Tip: For repetitive formulas (or functions), use the drag corner to fill adjoining cells, either horizontally or 
vertically. 

Nesting Operations 

When using operators such as + and *, Excel always assumes that multiplication and division take priority over 
addition and subtraction (see PEMDAS, page 1). Therefore, if you need to add two numbers, then multiply by a 
third number, you muse identify which step to do first by placing it in parentheses. 
 

Formula Result Action 

=2+4*3 14 This formula multiplies 4*3 (which equals 12), then adds 2. 

=(2+4)*3 18 This formula nests 2+4 (6), then multiplies by 3. 

=((9-2)/3)+6 8.33 Subtracts 9-2 (7), then divides 7 by 3 (2.33), then adds 6. 

=(2+3)^2*4 100 First add 2+3 (5), then square it (25), then multiple times 4 (100). 

Absolute Cell Addresses 

When using commands such as “Copy” or “Fill” to move or repeat functions, you have to remember that cell 
addresses change when they are moved; for example, if you shift a formula in C1 that reads =a1+b1 to the cell D1, 
it will change automatically to read =b2+c2—every reference shifts over a cell.  To prevent that from happening, 
you can “lock” a cell address by making it absolute.  Absolute cells are identified by the $ symbol:  $B1 locks the 
column; B$1 locks the row; $B$1 locks both column and row.  This is especially useful in calculating complex 
forumlas, such as percentages: 
 

 A B C Formula Result 

1 Jan 43         48.31    =(B1/$B$4)*100  Divide 43 by 89 (the total), then multiply by 100 

2 Feb 34         38.20    =(B2/$B$4)*100  Divide 34 by 89 (still the total), then multiply by 100 

3 Mar 12         13.48    =(B3/$B$4)*100  Divide 12 by 89, then multiply by 100 

4 Total 89       100.00    =SUM(C1:C3) Sum 48.31+38.20+13.48 

 

Excel Tip: The shortcut key for making a cell absolute is F4. If you press it once, you lock both column and row, 
press again to lock just the column, press again to lock just the row, press a fourth time to unlock the formula. 

Functions  

A function is a mathematical or logical operation that Excel provides for you. It contains a name and an “argu-
ment.”  For instance, rather than typing =B5+C5+D5+E5+F5, you might create the function =SUM(B5:F5), where 
B5:F5 is the argument. Some arguments are very simple, such as the one for a basic SUM, and others are more 
complex, as shown in the table on the next page. 
 
Be careful when selecting functions. There are often many variations of the same function, so use your help screen 
to make sure you are picking the one that will most accurately do the task you need to accomplish. For example, 
there is a function called “count” (returns a total of how many numbers you have), but there is also “countA” (how 
many cells with content, numbers or text), “countBlank” (how many cells are empty), and “countIf” (count on a 
conditional basis, such how many numbers are >25). 
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Figure 1. A Few Commonly Used Functions 

 
  

Excel Tip: One of the most useful commands in Excel is on the “Formula” tab of the ribbon, called “Show Formu-
las.” This command toggles formulas and functions to show so you can see where they are in use—so you can print 
them out to have a hard copy for future reference.  

Some commonly used functions in Excel:

Function Explanation Example Result
AVEDEV Average Deviation of data points from the mean; a measure of the 

variability in a data set; can contain numbers of cells.

AVEDEV(13,19,27,33) 7

AVERAGE Average of the data set; contains numbers or cells. AVERAGE(13,19,27,33) 23

COUNT Count how many numbers are in a range of cells. COUNT(A1:D4) 2

COUNTA Count how many nonblank values (cells with contents, either text or 

numbers) are in a range of cells.

COUNTA(A1:D4) 13

COUNTIF Count how many numbers are in a range, based on a criteria COUNTIF(A1:D4>10) 5

DATE Returns the "serial number" of a particular date (the numeric value to 

Excel of that date); contains year, month, date.

DATE(96,12,25) 35424

DATEVALUE The "serial number" of the date used to convert a date typed as text 

into the numeric value (useful within other functions).

DATEVALUE("8/16/96") 35293

DAYS360 Results in the number of days between two dates based on a 360-

day year, useful for accounting systems based on twelve 30-day 

months; contains the start date and end date.

DAYS360("1/1/96","1/1/97") 360

DB Depreciation of an asset for a specified time, with a fixed-declining 

balance; cost  is the initial cost, salvage  is the value at the end, life  is 

the number of periods being depreciated, period  is the want to 

calculate for.

DB(cost,salvage,life,period) 

DB(1000,50,5,1)

($1,000 item, resale of $50, 5 

years, in the first year)

$451.00

FREQUENCY Frequency distribution of a range of values, at specified intervals (a 

second range of values called "bins").

FREQUENCY(range,bins)

FV

Future value of an investment based on periodic, constant payments 

and constant interest rate; rate  is the interest rate per period, nper  is 

the total number of payment periods, pmt  is the payment per period.

FV(rate,nper,pmt)

FV(0.08125/12,24,100)

($2,596.49)

HOUR Shows the value of an hour of day. HOUR("3:30 pm") 15

IF Returns one value if logical test is true and another if false; logical 

test  is an instruction, such as > or < or +, value_if_true or 

value_if_false is a value to report if true (or false).

IF(logical test,value_if_true, 

value_if_false)

IF(d13>10,"wow","oops")

wow

IPMT Interest payment for a specified period of time based on periodic, 

constant payments and constant interest; rate  is interest per period, 

per  is the period you want the interest for, nper  is total number of 

payments, pv  is the present value.

IPMT(rate,per,nper,pv)

IPMT(0.08125/12,1,360,93600)

($633.75)

MAX Maximum value in a range. MAX(d1:d15) 35424

MEDIAN Number in the middle of a set of cells. MEDIAN(d1:d15) 14

MIN Shows minimum value in a range of cells. MIN(d1:d15) -2596.49

MODE Most frequently occurring value in a range of data. MODE(5,9,4,5,3,2,6,1,5,9) 5

NOW Serial number of the current date and time; updates when document 

is used.

NOW() 8/3/2010 15:04

PI Inserts the value of PI, to 15 digits. PI() 3.141592654

PMT Periodic payment for an annuity, based on constant interest rate, 

number of payments, and present value.

PMT(rate,nper,pv)

PMT(0.08125/12,360,93600)

($694.98)

PPMT Payment on principal for a given period, based on rate, period to be 

calculated, number of payments, and present value.

PPMT(rate,per,nper,pv)

PPMT(0.08125/12,1,360,93600)

($61.23)

PV Present value of an investment, based on rate, number of payments, 

and payment each period.

PV(rate,nper,pmt

PV(0.08125/12,360,700)

($94,276.45)

ROUND Rounds a number to a specified number of digits. ROUND(2.149,1) 2.1

STDEV Estimate for the standard deviation based on a range of cells. STDEV(d1:d25) 25995.52

TIME Serial number of a particular time, in hours, minutes, seconds. TIME(16,45,15) 4:45 PM

TODAY Returns the serial number of the current date. TODAY() 8/3/2010
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Charting in Excel 

An Excel chart is based on numerical data you wish to graph. The key to charting is properly selecting the correct 
data to be included in the graph. Once selected (remember to use CTRL to skip portions, and you usually don’t 
include totals), click the Inert ribbon and pick your chart type (column, line, pie, bar, area, scatter, other). This 
automatically inserts the chart into your sheet, as well as adds three new tabs to the ribbon: Chart Tools: Design, 
Layout, and Format.  

Manipulating an Existing Chart 

 Selecting—To manipulate a chart, you first select or highlight it.  To do this, simply place your pointer any-
where in the chart and click once. Graphical “handles” should appear on the chart edges. 

 Moving—With the chart active, point the mouse at the frame or border outlining the chart, then click and 
drag, moving the mouse, and the chart moves with you. Note there is also a button on the ribbon called 
“Move Chart,” which lets you shift the chart to a new sheet (while keeping it linked to the data). 

 Resizing—To enlarge, shrink or change the shape of the chart, simply place the pointer on any of the “han-
dles” on the frame until the pointer’s shape changes into double-arrows, then click and drag. The outline you 
draw will change the chart accordingly. Corner handles enlarge and shrink. 

 Formatting—Clicking once on a chart will allow you to move the chart or change the dimensions.  But you may 
want to change other aspects of the chart as well. One option is to click once on any specific part of the chart, 
then right-click with your mouse to find “change” and “format” options. Alternatively, you can use the ribbon 
tabs, as explained below. Remember to click the Home tab for simple formats (font, size, center, color). 

 Deselecting—After completing your chart changes, simply “Click Away”—or click any where on the worksheet 
outside the chart. 

 

 Figure 2. Parts of a Chart 

 

Design 

 Change Chart Type—Opens the dialog window that allows you to select the kind of chart you wish to have 
(column, line, pie, bar, area, XY, stock, surface, doughnut, bubble, radar). There are multiple designs for each 
chart type; for example, for column charts, there are side-by-side, stacked, percentile, and front-to-back. 

 Save as Templates—Saves an edited chart as a template, so it can be re-used. 
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 Switch Row/Column—Flip the display of your data: switch x axis to y, and vice-versa. Changes the display and 
the formats. 

 Select Data—Re-select data to be included in the chart. Use this if you did not correctly select  your data at the 
beginning. 

 Chart Layouts—This option is an “expander” (see the drop-down arrow in the bottom right corner). When 
expanded, there are multiple layouts for each chart type, impacting the title, legend, axes, gridlines, and more. 

 Chart Styles—Another group that expands (use the drop-down), with a variety of color formats based on 
Themes (“Page Layout”). 

 Location—This feature allows you to move the chart from an embedded-in-the-spreadsheet object (which 
often means it is difficult to get it to print in an attractive way) to a separate, new sheet (its own worksheet). 
Having a chart on a linked sheet often makes editing and formatting (and printing!) much easier. 

Layout 

 Current Selection—First single left-click on the portion of the chart you would like to change. The part you click 
on appears in the top drop-down of this group. There is both a “format” command and a reset command. 

 Insert—Allows you to insert a picture, shape, or text box into the chart area. 

 Labels—This is where you control the text content. There are drop-downs for Chart Title (position, and more); 
Axis Titles; Legend; Data Labels (showing values on the chart); and Data Table (which appends the data in a ta-
ble beneath the graph. 

 Axes—Horizontal and vertical axes and gridlines. 

 Background—“Plot Area” is the actual chart background (on a 2-dimension graph). “Chart Wall” and “Floor” is 
the chart background and floor on a 3-dimensional graph. “3-D Rotation” swivels and tilts the graph. 

 Analysis—Adds Trendlines and Error Bars to a graph. 

 Properties—The name of the chart sheet. 

Format 

 Current Selection—First single left-click on the portion of the chart you would like to change. The part you click 
on appears in the top drop-down of this group. There is both a “format” command and a reset command. 

 Shape Styles—Predesigned or custom fills, outlines, and effects for the components of the chart (such as fill 
colors or borders or shadows). 

 Word Art Styles—Predesigned or custom text formats (including text color, text border, and text effects such 
as glow). 

 Arrange—Bring to front or send to back (used when there are multiple objects embedded within a chart. 

 Size—The horizontal and vertical dimensions of your chart. This is an alternative way of sizing, as opposed to 
dragging handles. 

Sparklines 

Sparklines are a different kind of chart, which is embedded within a cell. It is meant 
to give a quick visual summary, without having to actually create a chart. There are 
three kinds of sparklines: line, column, and win/loss. They are tied to the original 
numbers, and re-draw when the data change. 

Sorting 

There are three ways to sort in Excel. There are simple A-Z and Z-A sorts; if you elect to use either of these com-
mands, make sure you highlight all the data to be sorted. To alphabetize by the first column of the highlighted 
area, you can use the A-to-Z button on the ribbon. Warning! If you have three columns of information to be 
sorted, but you highlight only the first column, then only that data will be rearranged—not the other columns.  If 
this happens, remember to use Edit/Undo to reverse your last step. 
 

January 15%

February -12%

March 48%

Line

Column

Win/Loss

Figure 3. Sparklines. 
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If you wish to sort by some other column in the highlighted area, or if you wish to sort by multiple columns (such 
as Last Name AND First Name), use the dropdown on the Sort button and select “Custom Sort.”  This window 
(Figure 4), lets you select which column to sort by, and add multiple levels. Be sure to specify whether or not your 
data have headers (a title row, which you would not want to sort). 
 
 

Also see more about the Sort and the related feature called “Filters” on page 13. 

Printing 

The Print screen (located on the “File” tab) allows you to print the entire spreadsheet, the highlighted (selected) 
area, or page ranges (such as 2 to 4).  It also gives you a “Print Preview” so you can see what your document will 
look like when it prints and how it fits on the page. Print Preview has some of the most useful functions for print-
ing, including printing the gridlines, page numbers, and headers and footers. This screen also allows you to center 
your table on the page, and, if it is too large to fit, to shrink it to scale so it fits on one sheet. 
 
When you go to the File/Print command, at the top of the screen is the “Print” button and the number of copies; 
below that is the default printer, with a dropdown if you have multiple printers to choose from. Then you see 
“Settings.” 

Print Settings 

 Page Active Sheets—Allows you to select what you want to print: entire sheet, entire workbook (multiple 
sheets), highlighted area, or specific pages. 

 Print One Sided—Available if your printer can do duplex (front-to-back) printing. 

 Collated—If you are printing more than one copy, you can specify how your pages are organized. 

 Orientation—Portrait or landscape printing. 

 Paper Size—Letter, legal, or other. 

 Normal Margins—Set your print margins. 

 Scaling—Enlarge or shrink your document to fit a specific number of pages. 

Print Preview 

On this same screen is “Print Preview,” which shows you how your document will print based on the current Print 
Settings. At the bottom left corner is a scroll bar for moving through pages (if more than one page). If the lower 
right corner of the preview screen are two buttons, one to activate margins and one to control zoom (to enlarge or 
shrink your screen view, with no impact on the printout).  

 Figure 4. Custom Sort. 
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Page Setup 

At the bottom of the Print Settings is a link to go into Page Setup. Here you will find four tabs, with detailed set-
tings for Page, Margins, Header/Footer, and Sheet. 

Page 

 Orientation—Do you want to print your worksheet like a letter (a.k.a. - “portrait” or “tall”) or on it’s side 
(“landscape” or “wide”)? 

 Scaling—Very cool stuff!  Allows you to shrink or enlarge the contents of your worksheet on the paper.   
Example:  Let’s say you have a worksheet should fit on two pages.  But you want to see it on one.  Simply se-
lect the Fit to: button, and make sure it’s to 1 page wide by 1 page tall.  Voila, all on one page! 
Warning!  Don’t try to scale a 20 page worksheet onto one page. It’s unreable, and you might freeze (crash) 
the computer or worse. 

 Paper Size—Allows you to decide to what size paper you’ll be printing. 

 Print Quality—Determines the resolution of the printout in dpi (dots per inch). 

 1st Page—What number to start numbering with. 

 Options...—Allows you configure how your printer will print. 

Margins 

Allows you to set page margins, and the areas in which headers and footers will fit.  Also allows you to center your 
worksheet both horizontally and vertically on the page.  (Try this when working on small worksheets) 

Headers/Footers 

Headers are text that repeats at the top of every page.  Footers are the same, except they’re at the bottom of 
every page. The boxes display the current settings, which are usually blank. There are a number of quick-to-use 
built-in headers and footers on the drop-down below Header or Footer, respectively.   
 
But if you want to really customize your headers/footers, select the “Custom Header” (or Footer) button. This 
brings up a set of buttons, and below that, three boxes, labeled Left, Center, and Right Sections.  This displays what 
appears in the Headers and Footers.  You can type text in these Section boxes as well as insert various codes. 
 

 The “A” button allows you to select the fonts, styles and sizes to be used. 

 The “#” button will insert a code that will display the current page. 
 

Figure 5. Custom Header Screen. 
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 The “+  +” button inserts a code displaying the total number of pages in the worksheet. 

 The Calendar button displays the print date. 

 The Clock button inserts the print time. 

 The yellow folder button inserts the file path (such as c:/users/documents/work). 

 The green Excel logo button displays the filename. 

 The sheet button displays the sheet (tab) name. 

 The mountain button allows you to insert a graphic (such as a logo). 

 The final button (grayed out unless you have a graphic) is to format the picture (such as size). 

Sheet 

 Print Area—Displays the range selected to print. 

 Print Titles—If you have column headings you want repeated every page (similar to a Header, but different), 
select specific rows or columns to repeat. 

 Print: Gridlines—Selects or deselects the gridlines (does not affect the monitor display). 

 Comments—To print comments or notes within the document. 

 Draft Quality—Tells the printer to use less ink (so you don’t waste expensive color toner).  

 Black & White—Prints with no color or gray scale.  

 Row & Column Headings—If you want A,B,C Column headings, or 1,2,3 Row headings to appear. 

 Page Order—Determines how the multiple pages will print (down and across, or across and down—that is, 
which direction is page 2? Is it from left to right, then down, or top to bottom, then across). 

Quick Print 

On the Quick Access toolbar, one of the commands you can add is called “Quick Print.” (You can also add Print 
Preview.) Quick Print automatically sends your entire spreadsheet to the printer. 

Dates and Times 

Dates to Excel are serial numbers, where each subsequent day is accorded an increasing numerical value (starting 
on 1/1/1900, which makes it numerical day 1).   So, if the date equals, 
 Date  Serial # 
 Jan 1, 1900 = 1 
 Jan 2, 1900 = 2 
 Jan 1, 1901 = 366 
 July 4, 1995 = 34,884 
 January 1, 2009 = 39,814 
 
This can be very useful in doing math calculations with dates. For example, if you are a doctor in a hospital who is 
tracking patients, you might find it helpful to chart “days of survival” or “days under treatment.” If the patient 
started treatment on Sept. 14, 2007, and is still alive on October 1, 2011, that patient has “survived” 1,478 days: 

=today()-“9/14/2007” 
Formatting the date cell is the process by which you can change the numeric appearance. On the Format button of 
the Ribbon, under Format Cells, are the numerical formats, including an option for “Custom.” Below are some of 
the codes you can put into “Custom” to create your own date formats: 
 

Day Code Appearance Month Code Appearance Year Code Appearance 

d 7 m 11 yy 09 

dd 07 mm 11 yyy 2009 

ddd Tue mmm Nov   

dddd Tuesday mmmm November   

 
Here’s how you might manipulate the formatting codes to change the date’s appearance: 
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 Tuesday, November 7, 1995 dddd, mmmm d, yyy 
 7/11/95 d/m/y 
 Nov. 7, 1995 m. d, yyy 
 
Time, to further this concept, is accorded a decimal value, where if one day equals the value of one (1), then: 
 6:00 am .25 
 12:00 Noon .5 
 6:00 PM .75 
 

Excel Tip: There are several functions built into Excel for working with time. If you need to calculate payroll, for 
example, you might want to use the =hour function to convert hours into number (for subtracting) and the 
=minute function to do the same to minutes. Using these two functions, you can turn 3:45 PM into the values 15 
and 45. 

 

Database Operations: Sort and Filter 

Excel is not a database (Access is), but it does provide some easy-to-use database features. Databases are all about 
data (information management) and what you can do with that information. To better understand databases, 
here’s a simple model: 
 

First Last Age Income Gender 

Fred Smith 42 $35,000 M 

Sally Sampson 67 $45,000 F 

Joe Smith 54 $72,000 M 

Jane Jones 33 $60,000 F 

 
To understand databases, it’s important to know about records and fields. A record is all the information pertaining 
to a person, place, thing - or whatever it is the database is tracking.  So the record for Sally Sampson contains all 
the information pertaining to her and her alone. A field is a component of a record. For this database, the Fields 
are FIRST, LAST, AGE, INCOME, and GENDER. Here are some simple tasks you can do with a database: 
 

 Query or Find—Seeking and locating records that meet specific requirements: 
 Find all records for men (M)  Fred and Joe 
 Find all records for those older than 40 (>40) Fred, Sally, and Joe 

 Sort—Arranging all the records in either ascending or descending order: 
 List the records in alphabetical order, by last name Jane at the top, Fred at the bottom. 
 List the records in descending order, by income  Joe at the top, Fred at the bottom. 
 
It is important when creating a database to first have field headings in the first row, then don’t skip a row before 
starting to input the data. The database must be contiguous.   
 
To Sort: Click in any record, it doesn’t matter which one, but it must be under the field by which you want to 

sort. Then from the “Home” ribbon or from the “Data” ribbon, click the Sort/A-Z button to sort all the 
records in ascending order. Click the Z-A button to sort in descending order. Note that in Excel 2010, 
each complete record moves, not just the contents of that column. They have to; otherwise they’d be 
wrong. If you don’t highlight, Excel does it automatically, so you don’t scramble your data. 

To Filter: Click on any cell in the database.  Then select “Filter” from the “Home” ribbon, then choose “Filter” 
on the dropdown. Notice how the field headings (first row) get down-arrows to the right of each cell. 
Click on an arrow, and what appears are field contents of various records.  
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Referring back to the sample database above, if you select the down arrow for LAST, then select “Smith,” the 
database would appear to have only two records—Fred and Joe. Important! To redisplay all the missing records, 
you must click on the same down arrow, then click “Select All.”  This will restore all hidden data. 
 
To query for and display records for those age 40 and over, click on the “AGE” arrow and select “Custom.”  A dialog 
box appears that displays the Field Heading.  Below that is an equal sign.  Select one of the logical operators <,>,=, 
etc. to specify the criteria for the search. In this case, you would want the operator “is greater than or equal to.” 
Hit the TAB button or click in the neighboring box.  Type “40”.  Then select OK.  Only those records where the age 
is greater than 40 will be visible. 

Wildcard Characters 

? Any single character Sm?th  matches Smith, Smyth, Smoth, etc. 
* Any characters S*  matches Smith, Sampson, Soren-

son, etc 
# Any numeric digit 5##  matches 500 to 599 
[ ] Any characters in bracket Sm[iy]th  matches Smith or Smyth, but not 

Smoth 
- Any characters within the range 

(must be in brackets) 
J[N-Z]nes matches Jones but not Janes 

! Any characters except (must be in 
brackets) 

[!N-Z] excludes Jones but not Janes 

 

Text Operations 

There are a series of operations in Excel that can be applied to text (as opposed to numbers). Some of these are 
commands on the ribbon under the “Data” tab, while others are functions. 
 
On the “Data” tab is a series of commands called “Data Tools.” One Data Tool is “Text to Columns.” This command 
breaks text in one cell into separate cells, on the basis of a common character or symbol (such as comma or space). 
For example, suppose someone gave you a list of names and asked you to sort them, but they were typed in one 
column (not two), so the last name is not separate—which means you cannot sort by last name. “Text to Columns” 
will break the first name and last name into two columns (assuming you don’t have any middle initials). 
 
 Figure 6. Text to Columns. 
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There are also several functions that can be used with text: 
 

 Proper—This function “properly” capitalizes the beginning of words. If you had “jan smith” in a cell A1, the 
function =proper(A1) would give you “Jan Smith.” There are also functions called “upper” (for all upper-case) 
and “lower” (for all lower-case). 

 Concatenate—Also referred to as a “string” function, this command joins cells. If you had “Jan” in cell A1, and 
“Smith” in cell B1, you could use concatenate to put them together. For example, =concatenate(B1,”, ”,A1) 
would give you “Smith, Jan.” (Note the “, “ indicates text to be inserted between B1 and A1.) 

 Left or Right—This function trims text, from the left side or the right side. For example, if you had a cell A1 
with Social Security numbers, and you only wanted to use the last four digits, you would use =right(a1,4). 

 Len—How many characters does a cell contain? In a cell A1 that contains “Chicago,” =len(a1) would show 7. 

Subtotals and Consolidate 

If you have a large table with a lot of repetitive information, there are several features under the Data menu that 
will help you better organize, analyze, and present the information. 
 

 “Subtotals” looks for repetitive values and adds totals (or averages, counts, etc.) at each change in data. It also 
adds an outline toolbar for viewing on the left side of the spreadsheet. Subtotals can also be removed when 
no longer needed (i.e., this feature can be turned on and off; it is temporary and does not permanently alter 
data). The one requirement is that your data must be sorted by the item for which you wish to get subtotals. 

 “Consolidate” looks for repetitive values and collapses them into one, with a resulting total (or average, count, 
etc.).  The resulting consolidation is a new table, and is not linked to the source (see Pivot Tables below for 
similar options). Data do not have to be sorted to use Consolidate; however, you can only consolidate two 
columns. 

Scenarios 

Scenarios are very useful when you want to store multiple numbers in the same cells, and then select which set of 
numbers to display at a given time. This is used frequently by people who work with budgets, and want to show 
the budget based on varying assumptions.  
 
 You have a worksheet that displays this year’s sales figures.  You need to predict next years sales, based on na-
tional economic indicators.  But what if those figures change, up or down?  You can create scenarios based on how 
these indicators vary and will give different answers. 
 

To create a scenario within a spreadsheet, first enter the base 
set of numbers you want to work with (the starting point). 
Highlight the area that you want to be able to create the 
scenario for, then go to the “Data” tab on the ribbon and click 
the dropdown for “What-If Analysis.” One of your choices is the 
“Scenario Manager.” Start by clicking the “Add” button to 
create your first scenario; you must assign a unique name to it, 
and confirm the values. Once the starting scenario exists, click 
“Add” again and create a new set of values. Continue this 
process of “adding” scenarios until you have as many versions 
as you need.  
 
At the bottom of the scenario manager is the “Show” button, 
which allows you to select which scenario to show at any time. 
Only one can be shown at any given time. 
 
If you wish to show all your scenarios at once, then use the 

Figure 7. Scenario Manager. 
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“Summary” button, which will create a new table of all your values. At any time, you can go back to the Scenario 
Manager and show a different scenario, and also add, delete, or edit scenarios. (The “Merge” command lets you 
pull scenarios from other sheets.) 

Links 

There are three kinds of data links in Excel: linking across sheets (same file), linking across files (different work-
books), and linking to other programs (such as Word). 

Linking across Sheets and Workbooks 

To copy data from one workbook to another is pretty straightforward; simply highlight the source data, select 
Copy, then toggle to another workbook file, then Paste. However, when you try to cut or copy formulas, you often 
will get errors (such as “#REF”), because Excel always adjust formulas and functions to match the new locations. In 
the sample below, look what happens when I copy the D column in Sheet 1 and paste it to the B column in Sheet 2.  
 

         
 

       
 
Look at the formula in cell D3, and then see what happened when it copies to the next sheet’s cell B3. C3 on sheet 
one became A3 on sheet 2; B3 on sheet one became “Invalid Reference” on sheet 2. Everything was adjusted by 
two columns, since it was copied from D to B.  
 
There are a couple of ways around this problem. In Excel, when you paste (after a cut or copy), you will find a very 
useful dropdown on the “Paste” button (on the “Home” tab), which gives you options as to how your paste shou ld 
occur.  
 

 Formulas—Paste the formulas (which usually will mess up if across sheets or files).  

 Values—Paste the results, not the formulas. 

 Formats—Paste just the formats, not the content. 

 Comments—Paste any inserted notes. 

 Validation—Paste only data that pass a certain criteria (such as numbers >25). 

 All using Source theme—Paste fonts, colors, effects. 
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 All except borders—Don’t include borders in paste. 

 Column widths—Only paste the column width. 

 Formulas and number formats—Paste formatted formulas. 

 Values and number formats—Paste formatted values. 

 All merging conditional formats—Paste with conditional formats. 

 Skip blanks—Paste, eliminating blanks. 

 Transpose—Switch rows to columns, or columns to rows. 

 Paste Link—Establish a connection across sheets, so that if one changes, the other updates automatically.  
 
The best choices on this list are to paste Values, Values and Number Formats, and Paste Link. “Paste Link” will 
maintain a relationship between the two tables. That is, if the source cell in the source worksheet changes, the 
linked cell in the linked sheet will change accordingly. 

Copying or Linking to Word 

You can copy worksheet contents to your Word document quite easily. Highlight a cell or range of cells in Excel, 
choose Copy, then toggle to Word. Place your cursor where you want to insert the worksheet data, then simply 
choose Paste. The values of your data will appear in Word’s Table format.  
 
Alternatively, use Paste Special, where you will find the “Link” option (be sure to select that it is a link to Microsoft 
Excel Worksheet Object). Tables that are linked from Word back to Excel can only be updated or edited in Excel. If 
you need to email someone the Word document, the Excel link will not update and cannot be edited unless you 
also send them the Excel worksheet (unless the link is to a file that is on a shared network drive). 

Pivot Tables 

PivotTables are especially well-suited for taking enormous amounts of data and summarizing that data into useful 
reports. To rearrange the worksheet, simply drag and drop column headings to a new location on the worksheet, 
and Microsoft Excel crunches the data accordingly. The diagram on the next page depicts a typical PivotTable and 
highlights its moveable elements. 
 
To begin, you need raw data. The general rule is you need more than two sets of data (at least three columns) to 
work with—otherwise you have nothing to pivot. And it needs to be consistently entered (similar data in same 
columns or rows), although it does not need to be sorted. It also helps if you have column headings in the first row. 
 

Figure 8. Pivot Table. 
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The PivotTable Wizard 

To create a Pivot Table, place the cursor anywhere in the data area, and start the Pivot Table wizard from the 
Insert  tab on the Ribbon. The PivotTable wizard walks you though the process of creating a PivotTable. While 
there are many advanced options available to use, the simple results are that Excel creates a blank PivotTable 
structure. You then move the particular fields to the designated areas: column labels (headings at top), row labels 
(headings at the left), and values (the data to be summed or analyzed). You can have multiple fields in each cate-
gory. 
As you drag and drop these items into their respective areas, the resulting report is displayed. The next step is to 
further manipulate your data by rearranging different fields onto the table, or removing fields. This action is 
pivoting the data—what Pivot Tables are all about. You’ll find that all duplicate entries have been consolidated, 
and the data automatically sorted.  

Modifying Reports 

A Pivot Table can be modified to display different results such as averages, counts, minimums, maximums, etc. The 
Pivot Table field dialog box shows how to change this report to display percentages instead of total amounts. 
Numeric data fields can be summarized using SUM, AVERAGE, MAX, MIN, and the other aggregate functions 
including COUNT. (As with the Subtotals feature, text fields can only be summarized with the COUNT function.)  

Auto Formatting 

The next step is to understand how the automatic formatting controls can make data clean-up a snap. On the 
Ribbon are tabs for Options and Designs. Under Designs, Excel provides an assortment of formats to choose from. 
Simply choose a format, and your data is now more readable. Additionally, these automatic formats are persistent 
formats, which means the table's formatting will hold even as you continue to pivot your data around by dragging 
and dropping additional fields on the screen.  

Pivot Charts 

The next step is to turn your Pivot Table into a chart. On the Ribbon, under Options, click the Pivot Chart button to 
launch the chart screen, which then adds a chart to the table. Just as with Pivot Tables, Pivot Charts are interactive 
as well. Simply drag and drop the data onto the chart to see instant results.  

Advanced Options 

On the Options tab of the Ribbon is a dropdown with advanced options.  
Layout allows you to generate default field settings for the PivotTable during the wizard process.This screen is a 
little more graphical and might be preferred by some users. However, this utility does not add any additional 
functionality or save any particular steps. 

VLookup and HLookup 

(From Microsoft Excel’s Help Screen) You can use the VLOOKUP 
function to search the first column of a range of cells, and then 
return a value from any cell on the same row of the range. For 
example, suppose that you have a list of employees contained 
in the range A2:C10. The employees' ID numbers are stored in 
the first column of the range, as shown in this illustration. 
 
If you know the employee's ID number, you can use the 
VLOOKUP function to return either the department or the 
name of that employee. To obtain the name of employee 
number 38, you can use the formula  
 
=VLOOKUP(38, A2:C10, 3, FALSE).  

Figure 9. VLookup Table 
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This formula searches for the value 38 in the first column of the range A2:C10, and then returns the value that is 
contained in the third column of the range and on the same row as the lookup value ("Axel Delgado"). 
 
The V in VLOOKUP stands for vertical. Use HLOOKUP when your comparison values are located in a row across the 
top of a table of data, and you want to look down a specified number of rows. Use VLOOKUP when your compari-
son values are located in a column to the left of the data you want to find. 

Protecting a Worksheet 

“Protection” allows you to lock cells from the possibility that someone might change the contents.  Protection will 
allow you to also “hide” the cell—the answer will appear in the cell, but notice that the formula bar is empty.  
“Protection” is located on any of the Home expanded dialog boxes (such as for Font or Alignment), where there is 
a tab for Protection.  
 
Note that cells are automatically locked—but “protection” is not activated. The first step in protecting a worksheet 
is to “unlock” the cells you want to be editable (where people can make changes). Uncheck the “Locked” checkbox 
to make cells editable; put a check in the “Hidden” checkbox if you want to hide your formulas and functions on 
the Formula bar. 
 
Once you have unlocked the cells, you can the “protect” the sheet. This command is located on the “Review” tab 
of the ruler. You have an option to assign a password for unprotecting, so other users cannot bypass your lock 
without the password. You probably want to uncheck the box that says “Select locked cells”—users probably 
shouldn’t click protected cells, since they can’t work in them. Make sure you have a check in “Select unlocked 
cells,” so users can make changes in the areas you have made editable. 
 
Once you OK the “Protect Sheet” command, you can no longer click in any cells except those that were unlocked. 
You cannot make other cells editable unless you know the password (and if you forget your password, Microsoft 
will not help you!). 

Templates 

On the Office Button (in the upper left corner) is a command called “New.” This is where you will find, not only 
new blank spreadsheets, but dozens and dozens of spreadsheet templates already set up. These are free, but they 
must be downloaded onto your computer for use; once downloaded, they are stored  under “Installed Templates” 
for re-use. 
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Excel Keyboard Shortcuts 

Move to cell “A1” ...................................................................... CTRL-Home 
Move to “A” Column of worksheet ........................................... Home 
Go To ......................................................................................... F5 
Move to end or start of table or worksheet .............................. End + arrow or Ctrl-End 
Move one window Left/Right .................................................... Alt-Page Up/Alt-Page Down 
Move one window Up/Down .................................................... Page Up/Page Down 
Insert AutoSum .......................................................................... ALT+= 
Select entire Column ................................................................. CTRL+Spacebar 
Select entire Row ....................................................................... SHFT+Spacebar 
Clear Cell Contents .................................................................... Delete 
Clear Cell Contents, and Edit ..................................................... Backspace 
Recalculate Worksheet .............................................................. F9 
Switch from displaying Values/Formulas................................... CTRL+`(single left quotation mark) 
Edit a Cell’s Data ........................................................................ F2 
Edit a Cell’s Contents (data, notes, etc.) .................................... CTRL+F2 
Format Cells  .............................................................................. Ctrl-1 
Insert Cells  ................................................................................ Ctrl-SHIFT-= 

Other Keyboard Shortcuts 

Save ........................................................................................... CTRL-S 
New ............................................................................................ CTRL-N 
Open .......................................................................................... CTRL-O 
Print ........................................................................................... CTRL-P 
Select All .................................................................................... CTRL-A 
Undo last action ......................................................................... CTRL-Z 
Redo last action ......................................................................... CTRL-Y 
Absolute Cell Reference ($) ....................................................... F4 
Cut ............................................................................................. CTRL-X 
Copy ........................................................................................... CTRL-C 
Paste .......................................................................................... CTRL-V 
Find  ........................................................................................... CTRL-F 
Find & Replace ........................................................................... CTRL-H 
Fill Down  ................................................................................... CTRL-D 
Fill Right  .................................................................................... CTRL-R 
Help............................................................................................ F1 
Bold ............................................................................................ CTRL-B 
Italics .......................................................................................... CTRL-I 
Underline ................................................................................... CTRL-U 

Other Important Terms and Symbols 
< ............................................................ Less than 
> ............................................................ Greater than 
<= .......................................................... Less than or equal to 
>= .......................................................... Greater than or equal to 
<> .......................................................... Not equal to 
Circular .................................................. A cell is referencing itself 
Filter ...................................................... A database is being filtered (selected by specific criteria) 
 


